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Abstract In this tutorial, we demonstrate how to conduct simple and parallel mediation analyses

using the PROCESS macro for SPSS (Hayes, 2013). We begin by describing the principles of medi-

ation. We then present a step-by-step tutorial describing how to test statistical assumptions and

conduct a simple and a parallel mediation using data from a project exploring whether anxiety sen-

sitivity mediates the relationship between gender and sensation seeking in a sample of 295 under-

graduate students. Results of these analyses showed that anxiety sensitivity, and more specifically

the belief that bodily sensations are dangerous, explains part of the relationship between gender

and sensation seeking. Finally, we interpret these results as if we are presenting the findings in

a research article. The tutorial serves as a concrete and need-to-know introduction to simple and

parallel mediation.
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Introduction
In psychology, researchers are often interested in exam-

ining whether variables are related to one another. To

achieve this, they can conduct regression-based analyses.

Although causality cannot be inferred from this type of

analysis, researchers anchor themselves in a theoretical

framework to determine which variable is said to be the

outcome and which is said to be the cause of this outcome.

For instance, one might wonder if gender is related to var-

ious personality characteristics like impulsivity or sensa-

tion seeking. Conceptually, it would make more sense to

test whether gender predicts these characteristics than the

other way around. However, it would also be possible to

examine if these characteristics predict gender. A theo-

retical framework will help determine which option is the

most probable and useful way of conceptualising the rela-

tionship.

Moreover, theory may also guide researchers to postu-

late that the relationship between two variables is more

complex than meets the eye. To illustrate this, we will use

the example of gender and sensation seeking. Sensation

seeking refers to a personality trait implicating the search

for novel, intense, and complex sensations through vari-

ous experiences (Zuckerman, 1994). It has also been con-

ceptualized as a motivating need for novelty and intensity

(Roth & Hammelstein, 2012). In a meta-analysis, Cross,

Copping, and Campbell, 2011 determined that men scored

significantly higher on measures of sensation seeking than

women (d = 0.41). However, various factors may account
for the relationship between gender and sensation seek-

ing. Indeed, the underlying processes are certainly any-

thing but simple.

In cognitive-behavioural models of psychological phe-

nomena, behaviours, thoughts, and emotions mutually in-

fluence each other (Hofmann, Asmundson, & Beck, 2013).

A person may therefore choose to engage, or to not engage,

in activities that produce new and exciting sensations for
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Figure 1 Simple mediation using the mediating effect of anxiety sensitivity on the relationship between gender and

sensation seeking. Notes: a is effect of gender on anxiety sensitivity; b is effect of anxiety sensitivity on sensation seeking;
c′ is direct effect of gender on sensation seeking.

many reasons. Indeed, if a person interprets sensations,

such as rapid heart beat, sweating, and racing thoughts, in

a negative way (i.e., they do not like those feelings), then

they will likely seek less of these sensations. Many indi-

viduals fear sensations like these because of their possi-

ble negative consequences, a construct know as anxiety

sensitivity (Taylor, Zvolensky, Cox, Deacon, & Heimberg,

2007). Anxiety sensitivity has three dimensions: Physi-

cal Concerns (the beliefs that bodily sensations are life-

threatening), Cognitive Concerns (the belief that difficulties

concentrating are dangerous), and Social Concerns (the be-

lief that others will reject or laugh at observable anxiety

symptoms; Taylor et al., 2007). Women report higher anxi-

ety sensitivity than men (Stewart, Taylor, & Baker, 1997).

Consequently, women may seek exciting sensations less

frequently than men. It would be interesting therefore

to see whether gender affects sensation seeking through

its effect on anxiety sensitivity. More specifically, perhaps

gender affects levels of anxiety sensitivity, which in turn

may influence the tendency to seek novel and intense sen-

sations.

This kind of hypothesis can be tested using mediation

analysis (e.g., Hayes, 2013; MacKinnon, Fairchild, & Fritz,

2007; Preacher & Hayes, 2004; Rucker, Preacher, Tormala,

& Petty, 2011), wherein a mediator (M ; anxiety sensitivity)
is proposed to explain the relationship between an inde-

pendent variable (X ; gender) and an outcome variable (Y ;
sensation seeking; see Figure 1). This model is a simple me-

diation because there is only one mediator.

In this example, gender is proposed to influence anx-

iety sensitivity (a), which in turn would affect sensation
seeking (b). This is called the indirect effect (ab) of gen-
der on sensation seeking through anxiety sensitivity. This

indirect effect is obtained by multiplying a and b, the two

effects associated with this pathway (Hayes, 2013). In ad-

dition, there is the direct effect (c′), which is the effect of
gender on sensation seeking while keeping levels of anxi-

ety sensitivity constant (Rucker et al., 2011). When combin-

ing the indirect and the direct effects, you obtain the total

effect (c), which is in fact the result you would get by sim-
ply regressing sensation seeking on gender (Hayes, 2013;

Rucker et al., 2011). The coefficients associated with the

various pathways (i.e., a, b, ab, c′, and c) are essentially un-
standardized regression coefficients. We will see more on

their interpretations later in the tutorial.

The strength of the indirect and the direct effects will

determine the result of themediation analysis (MacKinnon

et al., 2007). If the indirect effect is significant, then it is

considered to be successful mediation (MacKinnon et al.,

2007). When this occurs, the direct effect may disappear

or remain significant. If it disappears, then there is com-

plete mediation (i.e., the effect ofX on Y is entirely due to
M ), whereas if it remains, then there is partial mediation
(i.e.,M does account for part of the relationship between

X and Y , but,X still predicts Y even when taking into ac-
countM ; MacKinnon et al., 2007).
This conceptualisation of partial versus complete me-

diation is very wide-spread in the scientific community

(Hayes, 2013). However, it does have its critics. Hayes

(2013) presents various arguments against the use of this

nomenclature. For instance, he posits that partial media-

tion is bound to occur because something will mediate all

effects; it is simply a question of finding it (Hayes, 2013).

The process behind variable associations is too complex

and is bound to be mediated by some factor or another.

Moreover, discovering that a variable completely medi-

ates the relationship between two others does not exclude

the possibility that other constructs, not assessed in the
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Figure 2 Parallel mediation using the mediating effect of three anxiety sensitivity dimensions in the relationship be-

tween gender and sensation seeking. Notes: an is effect of gender on anxiety sensitivity dimensions, women are coded as
0 andmen as 1; bn is effect of anxiety sensitivity dimensions on sensation seeking; c

′
is direct effect of gender on sensation

seeking.

study, may also play a role in the relationship (Hayes, 2013;

Rucker et al., 2011). In essence, just because a researcher

finds evidence for onemediator does notmean that it is the

whole story. Therefore, readers should be cautioned if they

choose to report their analyses using the partial-complete

view of mediation. However, given that it is widely used in

scientific articles, it is necessary to comprehend its defini-

tions to better identify its pitfalls.

Furthermore, simple mediation is the simplest of medi-

ation models. More complex models, such as parallel me-

diation, can includemore than onemediator (Hayes, 2013).

In parallel mediation, two or more variables (M1,M2, etc.)

are proposed to mediate the relationship between X and

Y (see Figure 2). These mediators are allowed to correlate
with one another, but not to influence each other in causal-

ity (Hayes, 2013). In parallel mediation, there are as many

indirect effects as there are mediators. With three medi-

ators, there are the a1b1, a2b2, and a3b3 pathways using
M1, M2, and M3 respectively. This model is useful since

it allows for a more complex assessment of the processes

through whichX affects Y . For example, anxiety sensitiv-
ity is a multidimensional construct assessing three related

but distinct beliefs: the belief that bodily sensations are

life-threatening (Physical Concerns), the belief that difficul-

ties concentrating are dangerous (Cognitive Concerns), and

the belief that others will reject or laugh at observable anx-

iety symptoms (Social Concerns; Taylor et al., 2007). These

dimensions may play different roles in the relationship be-

tween gender and sensation seeking. Using parallel medi-

ation, we can test the mediating effects of all three anxiety

sensitivity dimensions (see Figure 2). We would then have

three possible indirect effects: one through each anxiety

sensitivity dimension.

Well written and comprehensive books regarding me-

diation analysis are available for the interested reader

(e.g., Hayes, 2013). This paperwill more so act as a concrete

and need-to-know tutorial on simple and parallel media-

tion by extending the gender, anxiety sensitivity, and sen-

sation seeking example introduced above. After introduc-

ing the research question and briefly discussing the data

and the methods used to collect them, we will describe and

test the statistical assumptions of mediation. We will then

present a step-by-step on how to conduct the analyses. Fi-

nally, we will interpret the results as if we are presenting

the findings in a research article.

Example Mediation Analyses
To illustrate a mediation analysis, we will be using data

from a study examining anxiety sensitivity. Briefly, 297 un-

dergraduate students from the University of Ottawa partic-

ipated in an online study for course credit. One participant

did not identify a clear gender and was therefore elimi-
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nated considering our interest in gender differences. One

case with missing data was also deleted listwise, creating

a final sample of 295 participants consisting of 148 women

and 147 men. Since the statistical analyses themselves are

of current focus, further sociodemographic characteristics

will not be discussed. All study procedures were in accor-

dance with the Research Ethics Board of the University of

Ottawa and with the 1964 Helsinki declaration and its later

amendments.

Following informed consent, participants completed

the UPPS-P (negative Urgency, Premeditation, Persever-

ance, Sensation seeking, Positive urgency), a questionnaire

assessing impulsive behaviour (Lynam, Smith, Whiteside,

& Cyders, 2006). The UPPS-P has five subscales; Sensation

Seeking, Negative Urgency, Positive Urgency, (lack of) Pre-

meditation, and (lack of) Perseverance. For the current

study, we were interested in the Sensation Seeking sub-

scale (SSs), which conceptualizes sensation seeking as a
disposition to impulsive behaviour (Cyders, 2013).

Participants also completed the Anxiety Sensitivity

Index-3 (ASI-3; Taylor et al., 2007). The ASI-3 has three sub-

scales measuring to Physical Concerns (i.e., the belief that

bodily sensations are life-threatening; ASI.PHY), Cogni-
tive Concerns (i.e., the belief that difficulties concentrating

are dangerous; ASI.COG), and Social Concerns (i.e., the
belief that others will reject or laugh at observable anxi-

ety symptoms; ASI.SOC; Taylor et al., 2007). Therefore,
the supplemental dataset includes the following variables:

gender, ASI.TOT (ASI-3 total scale score), ASI.PHY,
ASI.COG, ASI.SOC, and SSs.1

In the introduction, we wondered if gender influences

levels of sensation seeking through its effect on anxiety

sensitivity. Considering that we have a total scale and three

subscale scores for anxiety sensitivity, we could go about

testing the mediating effect of anxiety sensitivity in many

different ways. The option that appears the most appropri-

ate is to begin by conducting a simple mediation using the

ASI-3 total scale as our mediator. If this analysis provides

support for our hypothesis, we could then do a parallel me-

diation with the three subscale scores to determine which

dimension of anxiety sensitivity is driving the mediation.

To conduct our analyses, we will be using version 23

of SPSS (IBM Corp., 2015) and the PROCESS macro for SPSS

(Hayes, 2013), which uses a regression-based approach to

mediation. This macro can be downloaded at the follow-

ing address: http://processmacro.org/download.html. As a

side-note, it is important to know that the PASTE option in

SPSS (which allows you to save your syntax, or method,

for later) cannot be used in the PROCESS macro. There-

fore, we suggest writing down all the steps taken and the

selected options to ensure that you can redo your analyses

at a later time.

Simple Mediation

Before running the analysis, we must first examine our

variables to determine if mediation is appropriate. You

may have noticed that gender, our independent variable,

is dichotomous. Thankfully, it is completely correct to con-

duct amediation analysis with a dichotomous independent

variable (Hayes, 2013). In fact, the interpretation that we

will be able to make of the coefficients will be even more

informative, as we will see later on when we examine our

results. Our other variables, anxiety sensitivity and sensa-

tion seeking, are on a Likert-type scale, which should lend

itself well to regression.

Assumptions.
We first need to consider statistical assumptions. We will

provide examples of assumption testing using our data (for

more details, see Field, 2013; Hayes, 2013).

Linearity. In regression analysis, the relationship be-
tweenX and Y should be linear to minimize error (Hayes,
2013). To our knowledge, no guidelines suggest a way of

assessing overall model linearity in mediation. However,

a mediation can be broken down into simple and multiple

regressions, which each need to fulfil the assumption. The

indirect effect should also be linear, which means that its

constituting effects (a and b) need to be linear. To exam-
ine these criteria for a simple mediation, you need to plot

residuals against predicted values in four regressions: X
predicting Y (c), X predictingM (a), M predicting Y (b),
and X and M predicting Y (combined linearity of b and
c′). Should a or b be nonlinear, Hayes and Preacher (2010)
outline procedures for determining and testing indirect ef-

fects.

We will follow this procedure by running a series of re-

gressions (Analyze > Regression > Linear). For
the sake of time and space, we will only present results re-

lating to the X and M predicting Y regression (note: all
other relationships respected the assumptions). First, en-

ter gender and ASI.TOT as the independent variables
and SSs as the outcome variable. In the Save tab, select
the standardized residuals. Then, in the Plots tab, select the

standardized regression residuals (ZRESID) for the Y axis
and standardized predicted values (ZPRED) for the X axis.
Optionally, after you have run the analysis, you may add

a Loess curve to the scatterplot by double-clicking on the

plot, and then going under Elements > Fit Line at
Total > Loess > Apply. Loess fits a non-parametric
curve that represents the relationship between variables

1
In the discussion, we will briefly discuss serial mediation. Therefore, we also included the Negative Urgency subscale (NUs) of the UPPS-P in the

dataset to provide readers with the possibility of conducting a serial mediation.
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Figure 3 Checking the linearity and homoscedasticity assumptions using the multiple regression standardized predicted

and residual values: The influence of gender and anxiety sensitivity on sensation seeking.

(Jacoby, 2000). As can be seen in Figure 3, the regression

appears fairly linear since the Loess curve centers close to

zero along the entire X axis.

Homoscedasticity. Estimation error should be relatively
equal across all predicted Y values. If it varies, then we
have heteroscedasticity, which affects the standard error

of the regression coefficients (Hayes, 2013). To check ho-

moscedasticity, return to the same plot that we created to

examine linearity, but this time look for consistency in ver-

tical range across the X axis. In other words, see if the data

spreads on the Y axis consistently and equally through-

out the plot, resembling a rectangle. Our data in Figure

3 shows a relatively constant vertical range.

Normality of estimation error. Estimation error should
be normally distributed (Hayes, 2013). To examine this

assumption, we can create a Q-Q plot with the residuals

we saved from the regression by going under Analyze >
Descriptive Statistics > Q-Q Plots. The re-
sulting plot for theX (gender) andM (anxiety sensitivity)

predicting Y (sensation seeking) multiple regression can

be seen in Figure 4. Our data fit well with the diagonal line,

indicating normality. When there are minor violations to

this assumption, the results of the analysis should not be

affected unless the sample size is very small (Hayes, 2013).

Independence of observations. The error associated
with each data point (i.e., one case) should be independent

from the error of all other cases (Hayes, 2013). This is es-

pecially relevant for studies using cluster sampling proce-

dures or dyadic data research (Hayes, 2013), wherein cases

may be related to each other on the outcome because they

share some characteristics or context. In the presence of

nonindependence of observations, the standard error of

the regression coefficients could be either smaller or larger

than what it should be (Hayes, 2013). Only knowledge of

one’s own data collection method will allow a person to

determine if their data meets the independence assump-

tion. Given that we sampled our participants from an un-

dergraduate participant pool at the same university, it is

unlikely that we have underlying common characteristics

that would compromise the independence of our estima-

tion error.

The analysis.
Now that we have determined that our data respects mul-

tiple regression assumptions relatively well, we can con-

duct our simple mediation. Once the PROCESS macro has

been installed on SPSS, you may access it by going un-

der Analyze > Regression > PROCESS. You will
be greeted with the window shown in Figure 5. You will

need to use the center arrows to guide your variables to the

appropriate boxes. We want gender as the independent
variable, ASI.TOT as theM Variable, and SSs as the out-
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Figure 4 Checking the normality of estimation error assumption using the multiple regression standardized residuals:

The influence of gender and anxiety sensitivity on sensation seeking.

come variable. On the left-hand side, you will see various

options. First, Model Number refers to the type of analy-

sis we want to run. The default setting is 4, which is the

one we want since it is for simple and parallel mediation

(for the use of other model numbers, the interested reader

can refer to Hayes, 2013). Second, we must decide which

type of bootstrapping to use for the indirect effects. This

technique merits explanation before we continue with the

analysis.

Bootstrapping is an alternative way to perform null hy-

pothesis testing that can be applied to the test of the in-

direct effect (ab) to determine if it is different from zero
(Hayes, 2013). When using null hypothesis testing for an

indirect effect, one assumption is that ab is normally dis-
tributed (i.e., if we were to redo the study multiple times,

determining ab for each, the distribution of ab should be
normal). Bootstrapping does not assume that ab is normal
and therefore is preferable since we cannot really know

the shape of the indirect effect’s distribution in the popula-

tion. Bootstrapping is a resampling method (Hayes, 2013).

The goal is to construct a confidence interval around the

examined effect (in our case, around the indirect effect

ab). To achieve this, the current sample (of size n) is used
as a mini population. We have 295 participants, who we

believe adequately represent the population from which

they came, the undergraduate students of the University

of Ottawa. The computer will take a random bootstrap

sample of observations (of size n) within this mini popula-
tion with replacement. This means that some observations

may be selected multiple times or not at all within each

bootstrap sample. The computer will repeat this process

thousands of time, each bootstrap sample being slightly

different. Hayes (2013) recommends and uses 10,000 boot-

strap samples. The analyses are then run on all these boot-

strap samples to obtain the desired statistic for every one of

them. Hence, if there are 10,000 bootstrap samples, there

will be 10,000 computed indirect effects. These effects are

then placed in ascending order to determine the lower and

upper bounds of the confidence interval (CI), usually a 95%

CI. An example 95% CI may resemble −0.023 to 0.265,
−0.416 to−0.146, or 0.024 to 0.137. In the first case, the CI
includes zero, which would indicate that the indirect effect

is not significant because zero is in the realm of possible

values for the effect. In the latter two cases, the CIs do not

include zero and are entirely below or above zero. We can

therefore say with 95% confidence that the indirect effect

is negative in the second case and positive in the third case.

For our analysis, we will use 10,000 bootstrap samples

and select the Bias Corrected method of bootstrapping. Ex-

amining the pros of bias-corrected bootstrap CIs over other

methods is beyond the scope of this paper; the interested

reader may refer to Hayes (2013). Lastly, we will select a
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Figure 5 Screen capture of the completed opening PROCESS procedure window in SPSS (version 23).

95% confidence level. If we had covariates, we could also

select which variables we would like them to influence (M
and/or Y ). Since we do not have any covariates, it does not
matter which option is selected. The screen should resem-

ble the window shown in Figure 5.

Next, under the Options tab, we will select Ordinary

Least Square/Maximum Likelihood (OLS/ML) confidence

intervals to obtain CIs for effects other than the indirect ef-

fect which uses bootstrapping (optional if you do not wish

to present these), Effect size, and Total effect model (see

Figure 6). Additionally, PROCESS by default only allows for

variables that are eight characters or less to be entered in

the analysis. If your variable names are longer than eight

characters, you may go in the Long Name tab and allow

long variable names.

We are now ready to click OK on the main window. It

may take some time before results appear in the output

window. This is normal considering the work the com-

puter must do to compute the bootstrap CIs. The output

from PROCESS should resemble Listing 1 given at the end

of the article.

Several key points should be noted in this output. Lines

8 to 14 remind the researcher of the model (number 4),

the variables, the sample size, the number of bootstrap CIs,

and the level of confidence. Lines 16 to 39 show the regres-

sions associated with the mediator and the outcome vari-

able. It is these coefficients we will be using to construct a

diagram to represent our mediation. We will return to this

in the interpretation of our results. Also, all coefficients in

this output are unstandardized ones. If you would like to

obtain standardized coefficients, you may transform your

variables into Z scores before entering them in the medi-

ation. Considering that our independent variable is gen-

der, it would have been inappropriate to standardize as it

would have produced coefficients without any real mean-

ing.
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Figure 6 Screen capture of the Options menu of the PROCESS macro in SPSS (version 23).

Continuing, Lines 42 to 51 present the total effect model

that we requested in the options. As previously explained,

the total effect (c) is the result you would obtain by simply
regressing sensation seeking on gender without considera-

tion of the mediator. You may notice that these values are

identical to those in the next section of the output. The in-

teresting information in the Total Effect Model section is

the R-squared, which tells us how much variance in sen-

sation seeking our model can explain. In our case, we are

explaining 4% with our model, which indicates that many

other factors are influencing sensation seeking.

Direct effect. Finally, Lines 52 to 85 give information on
the direct and indirect effects. Recall that, in our dataset,

our X is coded by a unit difference (women coded as 0;

men coded as 1), which means that the effects can be in-

terpreted as mean differences between women and men

(Hayes, 2013). It appears that men scored 0.201 points

higher on sensation seeking than did women when levels

of anxiety sensitivity were kept constant. However, if we

had coded men as 0 and women as 1, we would then say

that women scored 0.201 points lower on sensation seek-

ing than did men when levels of anxiety sensitivity were

kept constant.

Indirect effect. You will notice that the output presents
three versions of the indirect effect: the indirect effect, the

partially standardized indirect effect, and the completely

standardized indirect effect. The indirect effect, similar to

the direct effect, is presented using the metrics of X and

Y , such that for every increase in one unit on X , there
is a change of ab units on Y (Hayes, 2013). For example,

we can say here that men scored 0.029 points higher than

women on sensation seeking as a result of the indirect ef-

fect through anxiety sensitivity. However, what does 0.029

mean? Is it a small or a large increase in sensation seek-

ing? The bootstrap CI is completely above 0, so we know

with 95% confidence that the indirect effect is positive, but

we still do not know if the increase in sensation seeking is

notable. In addition, scores on the SSs vary from 1 to 4,
but these are arbitrary values that carry no real meaning.

Partially standardized indirect effect. It is possible to
change part or all of the metrics used to describe the indi-

rect effect to add to its interpretation. The partially stan-

dardized indirect effect expresses ab using the original

metric ofX , but the standard deviation of Y (Hayes, 2013).
In our case, men scored 0.048 standard deviations higher

on sensation seeking than women as the result of the indi-

rect mechanism of anxiety sensitivity.

Completely standardized indirect effect. It is possible to
even further standardize the indirect effect by expressing

ab using the standard deviations of both X and Y (Hayes,
2013). As such, we could say that an increase by one stan-

dard deviation on gender produced an increase of 0.024

standard deviations on sensation seeking through the indi-

rect effect of anxiety sensitivity. However, considering that

our X variable is dichotomous, this makes little sense. In-

deed, the values we associated with men and with women

were arbitrary. An increase in one standard deviation

in gender therefore is uninterpretable. Completely stan-

dardized indirect effect can be used with other types of

variables, but it is not appropriate for dichotomous ones
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Figure 7 The mediating effect of anxiety sensitivity in the relationship between gender and sensation seeking. Notes:

*p < .05, **p < .01, # p < .001; All presented effects are unstandardized; a is effect of gender on anxiety sensitivity,
women are coded as 0 and men as 1; b is effect of anxiety sensitivity on sensation seeking; c′ is direct effect of gender on
sensation seeking; c is total effect of gender on sensation seeking.

(Hayes, 2013). Thus, for our analyses wemay use either the

unstandardized indirect effect or the partially standard-

ized indirect effect. The important thing will be to specify

which one we choose in the text or in a figure note.

Interpretation of results.
To finish the section on simple mediation, we will present

the results of our analysis as we would in amanuscript. All

information comes from the PROCESS output.

Results from a simple mediation analysis indi-
cated that gender is indirectly related to sensa-
tion seeking through its relationship with anx-
iety sensitivity. First, as can be seen in Fig-
ure 7, men reported less anxiety sensitivity
than women (a = −3.584, p = .042), and
lower reported anxiety sensitivity was subse-
quently related to more sensation seeking (b =
−0.008, p =< .001). A 95% bias-corrected
confidence interval based on 10,000 bootstrap
samples indicated that the indirect effect (ab =
0.029) was entirely above zero (0.003 to 0.074).
Moreover, men reported greater sensation seek-
ing even after taking into account gender’s in-
direct effect through anxiety sensitivity (c′ =
0.201, p = .003).

Parallel mediation

The results of our simple mediation suggest that anxiety

sensitivity mediates the relationship between gender and

sensation seeking. However, anxiety sensitivity has three

dimensions: Physical, Cognitive, and Social Concerns (Tay-

lor et al., 2007). It would be interesting to know if any of

these dimensions drive the mediation more than the oth-

ers, or if all three contribute to it. We can answer this

question using parallel mediation. Recall that mediators

in a parallel mediation are allowed to correlate, but not to

causally influence each other. Considering that all three

dimensions are assessed in one questionnaire and that we

have no theoretical reason to believe that one dimension

would lead to another, parallel mediation is appropriate.

On the other hand, if we believed that one dimension led

to another then serial mediation (see the conclusion for

a more in-depth description of serial mediation) would

be the appropriate choice. With parallel mediation, we

can test each proposed mediator while accounting for the

shared variance between them (Hayes, 2013). However,

mediators that are too highly correlated may create mul-

ticollinearity, which affects the estimation of their partial

relationships with the outcome variable (Hayes, 2013).

Assumptions. We verified the assumptions using the
samemethodswe used for simplemediation, only this time

we conducted seven additional regressions (i.e., X [gen-

der] predicting eachmediator [the three anxiety sensitivity

dimensions]; each mediator predicting Y [sensation seek-
ing]; X and all three mediators predicting Y ; note: we al-
ready had regressed Y onX for the simple mediation). We
noted no major assumption violations.

The analysis. To conduct our parallel mediation, we will
go to the same PROCESS window as before, which should

resemble Figure 8. The order in which you place the medi-

ators will not affect the results of the parallel mediation.

Next, under the Options tab, we will select OLS/ML con-

fidence intervals, Effect size, Total effect model, and Com-

pare indirect effects. Once again, if your variable names

are longer than eight characters, you may also go in the

The Quantitative Methods for Psychology 1562

http://www.tqmp.org
http://crossmark.crossref.org/dialog/?doi=10.20982/tqmp.13.3.p148


¦ 2017 Vol. 13 no. 3

Figure 8 Screen capture of the completed opening PROCESS procedure window in SPSS (version 23).

Long Name tab and allow long variable names. Click OK

on the main PROCESS window to obtain the output in List-

ing 2.

This output is very similar to the simple mediation

analysis, with some key differences. First, there is a sec-

tion that presents the unstandardized coefficients for each

“outcome”, that is for each mediator and the final outcome

variable (sensation seeking). Then, we have once again

the total effect model, which is the same as for the sim-

ple mediation we ran earlier since, if you recall, the total

effect is the result obtained by simply regressing sensation

seeking on gender. Next, we can see information on the

direct effect of gender on sensation seeking. The results

are slightly different than they were for the simple medi-

ation because we have different mediators entered in the

model (i.e., three separate mediators versus one combined

mediator) that account for a different proportion of the to-

tal effect. Here, men scored 0.172 points higher on sen-

sation seeking than did women when levels of the three

dimensions of anxiety sensitivity were kept constant. In

addition, if you examine the indirect effect section of the

output, you will see the total indirect effect, which is the

sum of all indirect effects. This statistic is often not of inter-

est because we usually want to look at the specific indirect

effects (Hayes, 2013). Indeed, it appears that the only indi-

rect effect that is different from zero with 95% confidence

is the Physical Concerns subscale of the ASI-3, as evidenced

by the bootstrap CI for Physical Concerns that is completely

above zero. Thus, we can say here that men scored 0.058

points higher than women on sensation seeking as a result

of the indirect effect through the physical concerns of anx-

iety sensitivity, holding all other mediators constant.

Next, you will find pairwise comparisons between the

specific indirect effects (denoted by C1, C2, and C3). The

legend for these contrasts is at the end of the output. It

should be noted, however, that these comparisons do not
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Figure 9 The mediating effect of three anxiety sensitivity dimensions in the relationship between gender and sensation

seeking. Notes: *p < .05, **p < .01, #p < .001; All presented effects are unstandardized; an is effect of gender on anxiety
sensitivity dimensions, women are coded as 0 and men as 1; bn is effect of anxiety sensitivity dimensions on sensation
seeking; c′ is direct effect of gender on sensation seeking; c is total effect of gender on sensation seeking.

allow to test if one indirect effect is larger than another;

they simply tell us if the effects are different (Hayes, 2013).

For example, if one indirect effect is .20 and another is

−.20, the contrast would probably identify these effects as
being different, which they are because one is positive and

the other is negative even if they are of the same strength.

However, if both indirect effects are of the same sign, then

a significant contrast may be interpreted as one effect be-

ing larger than the other (Hayes, 2013). Here, we can see

thatC1 andC2 are significant. With the help of the legend,

we can determine that the indirect effect through the Phys-

ical Concerns subscale is larger than the two other indirect

effects. For other analyses wherein more than one effect

is significant, the contrasts may also provide additional in-

teresting information.

Interpretation of results. Once again, we will present
the results of our parallel mediation as we would in a

manuscript.

Results from a parallel mediation analysis in-
dicated that gender is indirectly related to sen-
sation seeking through its relationship with the
Physical Concerns subscale of anxiety sensitiv-
ity. This dimension pertains to the fear of phys-
iological sensations because of the belief that
they may have negative consequences and are
life-threatening. First, as can be seen in Figure

9, men reported less fear of physiological sen-
sations than women (a1 = −2.021, p = .004),
and lower reported fear of physiological sen-
sations was subsequently related to more sen-
sation seeking (b1 = −0.029, p < .001). A
95% bias-corrected confidence interval based on
10,000 bootstrap samples indicated that the in-
direct effect through fear of physiological sen-
sations (a1b1 = 0.058), holding all other media-
tors constant, was entirely above zero (0.017 to
0.132). In contrast, the indirect effects through
both the Social and the Cognitive Concerns sub-
scales of anxiety sensitivity were not differ-
ent than zero (−0.004 to 0.038 and −0.047
to 0.005, respectively; see Figure 9 for the ef-
fects associated with these pathways). More-
over, men reported greater sensation seeking
even when taking into account gender’s indirect
effect through all three dimensions of anxiety
sensitivity (c′ = 0.172, p = .011).

Discussion and Conclusion
Mediation analysis enables researchers to examine the

processes through which one variable affects another. Al-

though complex, modern computers and software make

conducting mediations much more approachable. Using
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Figure 10 The serial mediating effect of anxiety sensitivity and negative urgency in the relationship between gender and

sensation seeking. Notes: *p < .05, **p < .01, #p < .001; All presented effects are unstandardized; an is effect of gender
on mediators, women are coded as 0 and men as 1; bn is effect of mediators on sensation seeking; c

′
is direct effect of

gender on sensation seeking; c is total effect of gender on sensation seeking; d is effect of anxiety sensitivity on negative
urgency.

the PROCESS macro for SPSS (Hayes, 2013), we were able

to determine that anxiety sensitivity explains part of the

relationship between gender and sensation seeking. More

specifically, men reported less anxiety sensitivity than

women, and less anxiety sensitivity was associated with

more sensation seeking. We did not stop there, however.

We then wondered which dimension of anxiety sensitiv-

ity was driving the mediation. Using parallel mediation,

we found that the Physical Concerns dimension of anxi-

ety sensitivity was the only significant mediator of the re-

lationship. Men reported less fear of physiological sensa-

tions than women, which in turn led to more sensation

seeking. Considering the three dimensions of anxiety sen-

sitivity (Physical, Social, and Cognitive Concerns), it makes

sense that it is the Physical Concerns that played the great-

est role. Sensation seeking produces many physiological

sensations. A person who fears these sensations would

likely score high on the Physical Concerns subscale and

also engage in less activities that produce strong physio-

logical sensations.

In the introduction, we alluded to the fact that

regression-based analyses (including mediation) imply

causality, but that it is in fact a false sense of causality. Re-

searchers choose which variable is the outcome and which

is the predictor of this outcome, but the analyses could

also be run the other way around. In our simple medi-

ation example, we decided that anxiety sensitivity would

be the mediator in the relationship between gender and

sensation seeking. However, we could have also tested if

sensation seeking mediates the relationship between gen-

der and anxiety sensitivity. We chose the former because

we based ourselves in a cognitive-behavioural framework,

which suggests that beliefs (anxiety sensitivity) influence

behaviour (sensation seeking).

But what if we want to see if this sequence of elements

truly operates in this causal order? We could try running

the mediation analysis with the mediator and the outcome

in both possible configurations and see if the indirect effect

holds in each model. We could also conduct a longitudinal

study where we would measure anxiety sensitivity some

time before sensation seeking to establish evidence of tem-

poral precedence. However, to really determine if anxiety

sensitivity causally influences sensation seeking, wewould

need to conduct an experiment where we would manipu-

late anxiety sensitivity (by either inducing or inhibiting it

by, say, telling people that anxiety-related sensations are

either dangerous or harmless) and see how this manipu-

lation affects level of sensation seeking on a standardized

task. Trait levels of sensation seeking would also need to

be statistically controlled for in this experiment.

Furthermore, simple and parallel mediation are not the

only possible mediation models. In parallel mediation, we

saw that the mediators are allowed to correlate but not to

causally influence each other. If it is believed that one me-

diator leads to another, then a serial mediation would be

the preferred model (see Figure 10). Briefly, in serial medi-

ation the a or b pathway is mediated by a second mediator.
There are then indirect effects through each of the medi-
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ators (a1b1 and a2b2) and an indirect effect through both
mediators (a1db2). Essentially, it is like conducting a par-
allel mediation, but with an added pathway that tests the

causal relationship between the mediators. For instance,

maybe anxiety sensitivity affects a person’s tendency to

act rashly when faced with negative emotions, a construct

known as negative urgency (Cyders & Smith, 2007). Essen-

tially, a person who is afraid of the sensations associated

with negative emotions may act impulsively in order to

escape these sensations. Negative urgency could then af-

fect levels of sensation seeking. Figure 10 shows this ex-

ample of serial mediation.
2
The material we covered in

this tutorial can easily be applied to serial mediation and

you may practice this technique using the supplemental

dataset (note: in PROCESS, the model number for serial

mediation is Model 6). The interested reader can refer to

Hayes (2013) to learn about serialmediation inmore detail.

This paper presents only the tip of the iceberg regard-

ing mediation. It is based in our previous experiences with

this type of analysis, complemented with information from

much more comprehensive resources (e.g., Hayes, 2013).

We hope it will prove useful to researchers who are new

to the field or who require a quick refresher. Mediation is

a great tool to have in a statistical toolbox, whether it be

to conduct it yourself or to better understand the literature

that uses the technique.

Authors’ note
The authors thank Veronika Huta, and Simon G. Beaudry,
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Listing 1: Output from the PROCESS procedure in SPSS (version 23) for the gender, anxiety sensitivity, and sensa-
tion seeking simple mediation analysis.

1 Run MATRIX procedure:
2 ************* PROCESS Procedure for SPSS Release 2.16.1 ******************
3

4 Written by Andrew F. Hayes, Ph.D. www.afhayes.com
5 Documentation available in Hayes (2013). www.guilford.com/p/hayes3
6

7 **************************************************************************
8 Model = 4
9 Y = SSs
10 X = Gender
11 M = ASI.TOT
12

13 Sample size
14 295
15 **************************************************************************
16 Outcome: ASI.TOT
17

18 Model Summary
19 R Rfsq MSE F df1 df2 p
20 ,1188 ,0141 225,9784 4,1923 1,0000 293,0000 ,0415
21

22 Model
23 coeff se t p LLCI ULCI
24 constant 26,1351 1,2357 21,1506 ,0000 23,7032 28,5671
25 Gender -3,5841 1,7505 -2,0475 ,0415 -7,0292 -,1390
26

27 **************************************************************************
28 Outcome: SSs
29

30 Model Summary
31 R R-sq MSE F df1 df2 p
32 ,2822 ,0796 ,3244 12,6292 2,0000 292,0000 ,0000
33

34 Model
35 coeff se t p LLCI ULCI
36 constant 2,8641 ,0744 38,4869 ,0000 2,7176 3,0105
37 ASI.TOT -,0080 ,0022 -3,6364 ,0003 -,0124 -,0037
38 Gender ,2012 ,0668 3,0127 ,0028 ,0698 ,3327
39

40 ************************** TOTAL EFFECT MODEL ****************************
41 Outcome: SSs
42

43 Model Summary
44 R R-sq MSE F df1 df2 p
45 ,1948 ,0379 ,3379 11,5530 1,0000 293,0000 ,0008
46

47 Model
48 coeff se t p LLCI ULCI
49 constant 2,6537 ,0478 55,5384 ,0000 2,5597 2,7478
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50 Gender ,2301 ,0677 3,3990 ,0008 ,0969 ,3633
51

52 ***************** TOTAL, DIRECT, AND INDIRECT EFFECTS ********************
53

54 Total effect of X on Y
55 Effect SE t p LLCI ULCI
56 ,2301 ,0677 3,3990 ,0008 ,0969 ,3633
57

58 Direct effect of X on Y
59 Effect SE t p LLCI ULCI
60 ,2012 ,0668 3,0127 ,0028 ,0698 ,3327
61

62 Indirect effect of X on Y
63 Effect Boot SE BootLLCI BootULCI
64 ASI.TOT ,0288 ,0177 ,0027 ,0738
65

66 Partially standardized indirect effect of X on Y
67 Effect Boot SE BootLLCI BootULCI
68 ASI.TOT ,0488 ,0296 ,0043 ,1226
69

70 Completely standardized indirect effect of X on Y
71 Effect Boot SE BootLLCI BootULCI
72 ASI.TOT ,0244 ,0148 ,0022 ,0614
73

74 Ratio of indirect to total effect of X on Y
75 Effect Boot SE BootLLCI BootULCI
76 ASI.TOT ,1254 ,1295 ,0085 ,4062
77

78 Ratio of indirect to direct effect of X on Y
79 Effect Boot SE BootLLCI BootULCI
80 ASI.TOT ,1434 ,5763 ,0083 ,6730
81

82 R-squared mediation effect size (R-sq_med)
83 Effect Boot SE BootLLCI BootULCI
84 ASI.TOT ,0093 ,0066 ,0010 ,0294
85

86 ******************** ANALYSIS NOTES AND WARNINGS *************************
87

88 Number of bootstrap samples for bias corrected bootstrap confidence intervals:
89 10000
90

91 Level of confidence for all confidence intervals in output:
92 95,00
93

94 NOTE: Kappa-squared is disabled from output as of version 2.16.
95

96 ------ END MATRIX -----

Listing 2: Output from the PROCESS procedure in SPSS (version 23) for the gender, anxiety sensitivity, and sensa-
tion seeking parallel mediation analysis.

1 Run MATRIX procedure:
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2 ************* PROCESS Procedure for SPSS Release 2.16.1 ******************
3

4 Written by Andrew F. Hayes, Ph.D. www.afhayes.com
5 Documentation available in Hayes (2013). www.guilford.com/p/hayes3
6

7 **************************************************************************
8 Model = 4
9 Y = SSs
10 X = Gender
11 M1 = ASI.PHY
12 M2 = ASI.SOC
13 M3 = ASI.COG
14

15 Sample size
16 295
17 **************************************************************************
18 Outcome: ASI.PHY
19

20 Model Summary
21 R R-sq MSE F df1 df2 p
22 ,1657 ,0274 36,4396 8,2676 1,0000 293,0000 ,0043
23

24 Model
25 coeff se t p LLCI ULCI
26 constant 7,8919 ,4962 15,9047 ,0000 6,9153 8,8685
27 Gender -2,0211 ,7029 -2,8753 ,0043 -3,4046 -,6377
28

29 **************************************************************************
30 Outcome: ASI.SOC
31

32 Model Summary
33 R R-sq MSE F df1 df2 p
34 ,0867 ,0075 29,6116 2,2199 1,0000 293,0000 ,1373
35

36 Model
37 coeff se t p LLCI ULCI
38 constant 11,2162 ,4473 25,0753 ,0000 10,3359 12,0965
39 Gender -,9441 ,6337 -1,4899 ,1373 -2,1912 ,3030
40

41 **************************************************************************
42 Outcome: ASI.COG
43

44 Model Summary
45 R R-sq MSE F df1 df2 p
46 ,0524 ,0027 34,9672 ,8078 1,0000 293,0000 ,3695
47

48 Model
49 coeff se t p LLCI ULCI
50 constant 7,0270 ,4861 14,4568 ,0000 6,0704 7,9837
51 Gender -,6189 ,6886 -,8988 ,3695 -1,9740 ,7363
52

53 **************************************************************************
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54 Outcome: SSs
55

56 Model Summary
57 R R-sq MSE F df1 df2 p
58 ,3187 ,1016 ,3188 8,1959 4,0000 290,0000 ,0000
59

60 Model
61 coeff se t p LLCI ULCI
62 constant 2,8771 ,0829 34,7125 ,0000 2,7140 3,0402
63 ASI.PHY -,0289 ,0084 -3,4265 ,0007 -,0455 -,0123
64 ASI.SOC -,0074 ,0075 -,9909 ,3225 -,0222 ,0073
65 ASI.COG ,0125 ,0088 1,4223 ,1560 -,0048 ,0299
66 Gender ,1724 ,0671 2,5693 ,0107 ,0403 ,3045
67

68 ************************** TOTAL EFFECT MODEL ****************************
69 Outcome: SSs
70

71 Model Summary
72 R R-sq MSE F df1 df2 p
73 ,1948 ,0379 ,3379 11,5530 1,0000 293,0000 ,0008
74

75 Model
76 coeff se t p LLCI ULCI
77 constant 2,6537 ,0478 55,5384 ,0000 2,5597 2,7478
78 Gender ,2301 ,0677 3,3990 ,0008 ,0969 ,3633
79

80 ***************** TOTAL, DIRECT, AND INDIRECT EFFECTS ********************
81

82 Total effect of X on Y
83 Effect SE t p LLCI ULCI
84 ,2301 ,0677 3,3990 ,0008 ,0969 ,3633
85

86 Direct effect of X on Y
87 Effect SE t p LLCI ULCI
88 ,1724 ,0671 2,5693 ,0107 ,0403 ,3045
89

90 Indirect effect of X on Y
91 Effect Boot SE BootLLCI BootULCI
92 TOTAL ,0577 ,0235 ,0199 ,1152
93 ASI.PHY ,0584 ,0278 ,0168 ,1320
94 ASI.SOC ,0070 ,0096 -,0044 ,0384
95 ASI.COG -,0078 ,0114 -,0466 ,0053
96 (C1) ,0514 ,0288 ,0090 ,1268
97 (C2) ,0662 ,0362 ,0149 ,1665
98 (C3) ,0148 ,0169 -,0069 ,0665
99

100 Partially standardized indirect effect of X on Y
101 Effect Boot SE BootLLCI BootULCI
102 TOTAL ,0975 ,0386 ,0341 ,1897
103 ASI.PHY ,0987 ,0460 ,0287 ,2168
104 ASI.SOC ,0119 ,0161 -,0074 ,0651
105 ASI.COG -,0131 ,0191 -,0772 ,0092
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106

107 Completely standardized indirect effect of X on Y
108 Effect Boot SE BootLLCI BootULCI
109 TOTAL ,0488 ,0193 ,0172 ,0952
110 ASI.PHY ,0495 ,0230 ,0144 ,1086
111 ASI.SOC ,0059 ,0080 -,0037 ,0325
112 ASI.COG -,0066 ,0096 -,0386 ,0046
113

114 Ratio of indirect to total effect of X on Y
115 Effect Boot SE BootLLCI BootULCI
116 TOTAL ,2507 ,5783 ,0811 ,6446
117 ASI.PHY ,2539 ,9142 ,0679 ,7241
118 ASI.SOC ,0305 ,0607 -,0230 ,1913
119 ASI.COG -,0337 ,3114 -,2309 ,0288
120

121 Ratio of indirect to direct effect of X on Y
122 Effect Boot SE BootLLCI BootULCI
123 TOTAL ,3346 7,9496 ,0838 1,5885
124 ASI.PHY ,3388 9,9316 ,0708 1,8026
125 ASI.SOC ,0407 1,6297 -,0330 ,4503
126 ASI.COG -,0450 1,4064 -,6041 ,0410
127

128 Specific indirect effect contrast definitions
129 (C1) ASI.PHY minus ASI.SOC
130 (C2) ASI.PHY minus ASI.COG
131 (C3) ASI.SOC minus ASI.COG
132

133 ******************** ANALYSIS NOTES AND WARNINGS *************************
134

135 Number of bootstrap samples for bias corrected bootstrap confidence intervals:
136 10000
137

138 Level of confidence for all confidence intervals in output:
139 95,00
140

141 ------ END MATRIX -----

Open practices
The Open Data badge was earned because the data of the experiment(s) are available on the journal’s web site.
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